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File menu commands

The File menu offers the following commands:

New Creates a new Tracking List.
Open Opens an existing Tracking List.
Save Saves the active Tracking List using the same file name.
Save As Saves the active Tracking List to a specified file name.
Backup Backs up the active Tracking List.
Print Preview Displays full pages as they will be printed.
Print Prints the active Tracking List.
Password Change the password to protect access to your Tracking List.
Options Change the options of your Tracking List.
Exit Exits Password Tracker Deluxe.

Edit menu commands

The Edit menu offers the following commands:

Add Adds a new P-Track.
Properties Edit the selected P-Track's properties.
Notes Edit the selected P-Track's notes.
Change 
Password

Change the selected P-Track’s password.

Delete Delete the selected P-Tracks.
Send Send the selected user id and/or password to the program.
Copy User ID to 
Clipboard

Copy the user id to the clipboard.

Copy Password 
to Clipboard

Copy the password to the clipboard.

Copy Notes to 
Clipboard

Copy the notes to the clipboard.

Generate 
Password

Generate a new password.

View menu commands

The View menu offers the following commands:

User IDs Shows or hides the display of the user ids.
Shortcuts Shows or hides the display of the shortcuts.
Passwords Shows or hides the display of the passwords.
Notes Shows or hides the display of the notes.
Equally Space 
Columns

Equally space the visible columns.

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Preferences Set the program preferences.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics Offers you an index to topics on which you can get help.
Welcome Read the Password Tracker Deluxe welcoming message.
Registration 
Information

Read the Password Tracker Deluxe registration information.

Register Online Register your copy of Password Tracker Deluxe on-line using the Internet
Registration 
Number

Enter your Password Tracker Deluxe registration number.

Check for an 
Update

Check for an update to Password Tracker Deluxe.

About Display program information, version number and copyright.

New command (File menu)

Use this command to create a new Tracking List in Password Tracker Deluxe.

If you have the Use Wizards preference turned on, the Tracking List Wizard will guide you through 
creating a new Tracking List.

You can open an existing Tracking List with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing Tracking List.

You can create a new Tracking List with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
*.PWT Password Tracker Deluxe files.

Drives
Select the drive in which Password Tracker Deluxe stores the file that you want to open.

Directories
Select the directory in which Password Tracker Deluxe stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Save command (File menu)

Use this command to save the active Tracking List to its current name and directory.    When you save a 
Tracking List for the first time, Password Tracker Deluxe displays the Save As dialog box so you can 
name your Tracking List.    If you want to change the name and directory of an existing Tracking List 
before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active Tracking List.    Password Tracker Deluxe displays the 
Save As dialog box so you can name your Tracking List.

To save a Tracking List with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a Tracking List with a different name.    A filename can contain up to 250 
characters.    Password Tracker Deluxe adds the extension ".pwt".

Drives
Select the drive in which you want to store the Tracking List.

Directories
Select the directory in which you want to store the Tracking List.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four Tracking Lists 
you closed.    Choose the number that corresponds with the Tracking List you want to open.



Exit command (File menu)

Use this command to end your Password Tracker Deluxe session.    You can also use the Close 
command on the application Control menu.    Password Tracker Deluxe prompts you to save untitled 
Tracking Lists.    Changes to a Tracking List are automatically saved.

A dialog box will confirm exiting Password Tracker Deluxe.    It is recommended to minimize Password 
Tracker Deluxe so your passwords are quickly accessible.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common
commands in Password Tracker Deluxe, such as File Open.    A check mark appears next to the menu 
item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Password Tracker Deluxe.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Create a new Tracking List.

Open an existing Tracking List.    Password Tracker Deluxe displays the Open dialog box, in 
which you can locate and open the desired file.

Save the active Tracking List with its current name.    If you have not named the Tracking List, 
Password Tracker Deluxe displays the Save As dialog box.

Print the active Tracking List directly to the printer using the current defaults.

Send the selected user ID and password to the program.

Copy the user id to the clipboard.

Copy the password to the clipboard.

Copy the notes to the clipboard.

Adds a new password.

Edit the selected P-Track’s properties.

Edit the selected P-Track's notes.

Change the selected P-Track's password.

Delete the selected P-Tracks.

Generate a new password.

Displays the version number of this application.

Display help for clicked on buttons, menus and windows.



Offers you an index to topics on which you can get help.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state.    A check mark appears next 
to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Password Tracker Deluxe window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you
depress them, before releasing them.    If after viewing the description of the toolbar button command 
you wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Password Tracker
Deluxe.

Shortcut

Toolbar:



Context Help command

Use the Context Help command to obtain help on some portion of Password Tracker Deluxe.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the Password Tracker Deluxe window, such as another Toolbar button. 
The Help topic will be shown for the item you clicked.

Shortcuts

Toolbar:
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and 
document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll 
bars indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to 
other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow 
keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with
the arrow keys.

Note:    This command is unavailable if you maximize the window.



Minimize command (application Control menu)

Use this command to reduce the Password Tracker Deluxe window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcut
Keys: ALT+F4 closes the Password Tracker Deluxe window or dialog box.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying The Tracking List 

Use the commands on the Edit menu to add, edit or delete P-Tracks on your Tracking List.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



To close this dialog box and save any changes you've made, click OK.



To close this dialog box without saving any changes you've made, click Cancel.



Enter the password.



Enter the old password.



Enter a new password.    If blank, password protection of the Tracking List will be disabled.



Re-enter the new password to verify that it was typed correctly.



If checked, the Tracking List password is required to send the keystrokes to a program.



If checked, the passwords will never expire.



The number of days the passwords will expire in.



Use the up and down arrows to adjust the number of days the passwords will expire in.



Enter the sequence of keystrokes to send to the program.



To close Password Tracker Deluxe, click Exit.



To return back to Password Tracker Deluxe, click Cancel.



To minimize Password Tracker Deluxe, click Minimize.



Enter the name of the person registering the program.



Enter your valid registration number.



To read the on-line Registration Information, click Registration Information.



To read the help for the special send keystroke codes, click Special Codes Help.



To add a new word to the list, click Add.



To generate a complex password, choose Complex.



To delete the selected word, click Delete.



List of words used to generate a simple or complex password.



The generated password.



To generate a password consisting of random letters and numbers, choose Random Letters and Numbers.



To generate a simple password, choose Simple.



To modify the list of words used to generate a simple and complex password, click Word List.



To find the class name of a control, click Get Control Class Name.    Then, select the control with the left mouse key.



To register your copy of Password Tracker Deluxe by mail, click Register By Mail.



To remove Password Tracker Deluxe from your computer, click Uninstall.



To continue evaluating Password Tracker Deluxe, click Continue.



To backup the active Tracking List, click Backup.



To not backup the active Tracking List, click Cancel.



Enter the file name of the Tracking List backup file.



To select the options to generate a random letter and number password, click Options.



Enter the minimum number of characters for the password.



Enter the maximum number of characters for the password.



Use the up and down arrows to change the minimum number of characters for the password.



Use the up and down arrows to change the maximum number of characters for the password.



To register your copy of Password Tracker Deluxe on-line using the Internet, click Register On-line.



To select the backup file name by browsing your computer, click Browse.



Enter a new password.



To generate a new password, click Generate.



To change the synchronize properties, choose Synchronize.



Print command (File menu)

Use this command to print a Tracking List.    This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Note: The toolbar button prints directly to the printer using the current defaults.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the Tracking List should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire Tracking List.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Password Tracker Deluxe is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active Tracking List as it would appear when printed.    When you 
choose this command, the main window will be replaced with a print preview window in which one or two
pages will be displayed in their printed format.    The Print Preview toolbar offers you options to view 
either one or two pages at a time; move back and forth through the pages; zoom in and out of pages; 
and initiate a print job.



Print Preview toolbar

The Print Preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from Print Preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

This command is not available.



Welcome

Welcome, and thank you for taking the time to evaluate Password Tracker Deluxe!

We all know that using separate user names and passwords is smart computing.    It is also smart to 
change your passwords frequently.    Remembering all those user names and passwords, especially if 
you change them as often as you should, can be a real hassle.    That was before Password Tracker 
Deluxe.

Password Tracker Deluxe solves the problem of trying to remember multiple user names and passwords
for different programs.    All you need to do is enter the information into Password Tracker Deluxe’s 
database, assign the program window where you want the information to go, and you’re done.    The 
next time you need to enter user name and password information, just click on the Password Tracker 
Deluxe icon in the Windows 95/98/NT 4.0 System Tray, pick the correct "P-Track" and the data is 
automatically inserted into the program.    And with the wizards in Password Tracker Deluxe, using 
Password Tracker Deluxe has never been easier.

Password Tracker Deluxe does even more than just track your passwords.    Password Tracker Deluxe 
can even launch a program or URL.    Also, Password Tracker Deluxe can even send your commonly 
typed text to programs.

Password Tracker Deluxe is Year 2000 compliant.

Your favorite programs, web sites, and text entries are now just a simple click away.

Please take a moment to read the License Agreement and Registration Information now.

Once again, thanks for evaluating Password Tracker Deluxe.    We look forward to hearing from you 
soon!

Revision History

Password Tracker Deluxe 3.50
Added the ability to synchronize the passwords of multiple P-Tracks from the Change Password 

command.

Password Tracker Deluxe 3.48
Added a Generate Password command to the Edit menu.
Added a Change Password command to the Edit menu.
Added a program preference to turn off playing the sounds when automatically sending a P-Track

and asking to backup the Tracking List.

Password Tracker Deluxe 3.47
Added toolbar buttons for the commands Copy User ID to Clipboard, Copy Password to 

Clipboard, Copy Notes to Clipboard and Delete.
Fixed the ability to check for an update using a proxy server that requires authentication (thanks 

to Andrew Reeves-Hall for helping).

If Password Tracker Deluxe is registered, the registration commands on the Help menu are 
removed.

Password Tracker Deluxe 3.46



Added the Equally Space Columns command to the View menu to equally space the visible 
columns.

Open tracking list files are now locked to prevent access by other computers.

Added a Browse button to the Backup command.

Made a few other minor improvements.

Password Tracker Deluxe 3.45

Fixed a few problems with using the Windows cryptography algorithms to save Tracking List files.

Password Tracker Deluxe 3.44

Added the ability to send the pause/break key using the {pausekey} send keystroke code.

Improved the backup command by making it smarter and more user friendly.

Improved the performance of sending passwords, user ids and notes to other programs.

Added the ability to customize the system tray icon image.

Password Tracker Deluxe 3.43

Fixed the inability to send user ids, passwords and notes to a window with no title bar text.

Added the “thundertextbox” class name to the default edit control find procedure.    This particular 
edit control name is used by the Homewise program as well as possibly others.

Password Tracker Deluxe 3.42

Added the option to set the minimum and maximum number of characters for randomly generated
passwords.

Increased the security of the Tracking List files by adding the option to store Tracking Lists using 
the Windows encryption algorithms.

Added the Registration Information and Register Online commands to the Help menu.

Fixed the Check For An Update command error downloading the update information file for some 
computer configurations.

Password Tracker Deluxe 3.41

Added a registry setting to make the Password Tracker Deluxe interface hidden from the user.

Password Tracker Deluxe 3.40

Added the Backup command to the File menu.

Added the preference to automatically ask to backup the Tracking List.    The number of days 
between backups is user definable.

Added the ability to check for an update to Password Tracker Deluxe on the Internet.

Added user defined custom send keystroke sequences to the default send keystroke sequence 
list.

Added the ability to double click the extra space in the column headings to evenly space the 
visible columns.



Added the preference to turn off the P-Track icons on the system tray pop-up menu.

Password Tracker Deluxe 3.31

Added the ability to vertically scroll the tracking list window with a mouse wheel.

Password Tracker Deluxe 3.30

Added the ability to individually set the number of days a password will expire.    This is an 
advanced setting and can be set from the P-Track Properties Preferences with the Wizard turned off.

If Password Tracker Deluxe continuously runs, the password expiration column is updated around
midnight every day.

The system tray pop-up menu now displays the P-Track’s icon.

Fixed a few minor problems relating to registration and password generation.

Password Tracker Deluxe 3.24

Added the ability to send just the alt, control and shift keys using the codes {altkey}, {ctrlkey} and 
{shiftkey} respectively.

Fixed the system path to Password Tracker Deluxe that is configured during setup.

Password Tracker Deluxe 3.23

Added the ability to send a password to the America Online Setup and Sign On Welcome window.
Note: An AOL account P-Track should disable the automatic send during scan for playback windows 
preference.

Improved the select playback window title text command.

Fixed displaying P-Tracks with names containing the ‘&’ character on the system tray pop-up 
menu.

Fixed a few other minor interface problems.

Password Tracker Deluxe 3.22

Added the ability to send the function keys F13 to F24.

Fixed sending the F10, F11 and F12 keys.

Password Tracker Deluxe 3.21

Added a P-Track preference to not match the parent window title bar text when scanning for 
playback windows.

Added a P-Track preference to additionally match the window text when scanning for playback 
windows.

Adjusted the algorithm to locate the Netscape Navigator and Microsoft Internet Explorer 
executable files.

Fixed the window colors and fonts for some non-standard Windows configurations.

Password Tracker Deluxe 3.20

Added an individual P-Track preference to select which web browser to use when opening URLs 



and whether to view the page in a new window or a currently open window.

Added a preference to confirm exiting Password Tracker Deluxe.

Added a preference to not register Password Tracker Deluxe with the Windows Shell every time 
the program starts.

For some international versions of Windows 95, fixed sending keystrokes and installing Password
Tracker Deluxe to run when Windows starts up.

Password Tracker Deluxe 3.13

Added a preference to add or remove Password Tracker Deluxe from the Windows StartUp 
group.

Enhanced the security of information by requiring the Tracking List password to copy the user id, 
password and notes to the clipboard.

Password Tracker Deluxe 3.12

Fixed the Copy To Clipboard commands.

Fixed sending the user id and password when the playback window titlebar text equals “*”.

Password Tracker Deluxe 3.11

Added the ability to work with Microsoft Internet Explorer 4 and Microsoft Windows 98.

Added the ability to easily repeat keys.    For example: {tab 3}.

Added a continue button when finding edit controls in case an edit control cannot be found.

Added a continue button during a pause to skip the remaining pause time.

Password Tracker Deluxe 3.10

Added the ability to copy the user id, password and notes to the clipboard.

Added the preference to have Password Tracker Deluxe stay visible on top of all windows.

Added the Add New P-Track command to the system tray pop-up menu.

Added these send keystroke codes: {ctrl}, {alt}, {shift}, {escape}, {clipboard userid}, {clipboard 
password} and {clipboard notes}.

Added a preference to set the amount of time to pause before automatically sending a user id 
and/or password to a playback window.

Password Tracker Deluxe 3.02

Enhanced the security of information by requiring the Tracking List password to view the notes, 
modify a P-Track and delete P-Tracks.

Enhanced the online help.

The maximum number of system tray menu items is now 50.

Improved the process of sending the user id and/or password.

Password Tracker Deluxe 3.01

Added the ability to select how many system tray pop-up menu items are displayed and how they 



are sorted.

Added the individual preference to not add a P-Track to the system tray pop-up menu.

Added a Preferences command to the View menu.

When sending keystrokes, the first edit control is now automatically set as the input focus.

When sending the user id and password, the text in the edit control is now automatically replaced.

Fixed bugs relating to screen colors, non-standard keyboards, running Password Tracker Deluxe 
from the setup program, and finding playback windows.

Fixed a few other minor bugs.

Password Tracker Deluxe 3.0

Added the ability to launch a program or go to a URL.

Added the ability to scan for playback windows to automatically send the password to a program.

Added the ability to send the notes to a program.

Improved the printing format.

Made many other interface improvements.

Password Tracker 2.17

If registered, the program starts silently when Windows starts up.

The last window placement is now always restored when the program starts.

The last toolbar and status bar state are now restored when the program starts.

Password Tracker 2.16

Added the ability to have wild card characters for the playback window title bar text.

Password Tracker 2.15

Added more special send keystroke codes.    For example: {home}, {end}, {left}, {right}, {backtab}, 
{selectall}, {delete}.

You can now click in any column to select a P-Track.    The entire P-Track row is now also 
highlighted.

Improved the select playback window title bar text command.

Made other minor interface improvements.

Password Tracker 2.14

The pause times can now be in tenths of a second.

Fixed being able to send the space character in a user id or password.

The Tracking List name is now verified as a valid file name.

Improved the handling of invalid or corrupt Tracking List files.

Password Tracker 2.13



Fixed opening, printing and creating Password Tracker files using the Windows Explorer.

Setup will check and make sure Password Tracker is closed before installing the files.

Uninstallation will now remove all Password Tracker registry entries.

Password Tracker 2.12

The System Tray pop-up menu now only displays P-Tracks that are capable of sending the user 
id and/or password to a playback window.

Improved the print out.

Fixed a few other minor bugs relating to the System Tray menu.

Password Tracker 2.11

Improved the notes feature by word wrapping the text and not selecting the entire text when 
opening the notes dialog box.

Fixed a few minor bugs.

Password Tracker 2.10

Added the ability to track notes for each P-Track.

Refined the program and fixed a few minor bugs.

Password Tracker 2.01

Wizards were added to guide you through creating and modifying Tracking Lists and P-Tracks.

Tracking Lists can now be printed.

A right-click menu of commands is available for the selected P-Tracks.

The expiration date of the password is now also displayed.

Added more send keystroke codes (for example, {pause}) so even more playback windows work.

Increased the security of the Tracking Lists.

Refined the program and fixed a few minor bugs.

Password Tracker 1.0

The ability to track virtually an unlimited number of passwords.

Automatically send the user id and/or password to a dialog box requesting the password.

Quick access to your Tracking List via the Windows 95/NT 4.0 System Tray.

Option to password protect the Tracking List.

Option to be notified when passwords expire.

Context sensitive online help.



Registration Information

If you use Password Tracker Deluxe for more than 30 days, you are required to become a registered, 
licensed user.    Before using Password Tracker Deluxe, carefully read the License Agreement.

Registered users receive the following benefits:
1. Free upgrades via download from our web site or $5.00 US for upgrades on diskette sent via mail.
2. 60 days of product support via e-mail and mail from the date of registration.
3. A say in what Password Tracker Deluxe can do.    You are encouraged to let us know what new 

features you would like to see.
4. A registration number which removes the shareware evaluation version notifications.
5. A registration number which removes the splash screen when Windows starts up.
6. Your registration will ensure continued enhancements to Password Tracker Deluxe.

To register by mail, fill out the Registration Form and send it in.    You may also register on the Internet 
using your credit card.    The online registration is through a secure web site.    Visit our home page for 
details, http://www.bigfoot.com/~ptd.



Registration Form

To register Password Tracker Deluxe, send the following information along with a check, money order or
cash (US funds drawn from a US bank, payable to Robert P. Cannalte).    If you are registering more 
than one copy, you may optionally submit forms for each additional user.    Please print or type clearly.    
Especially the e-mail address since that is our main form of communication to you.

1. Registration Count Fee Quantity Total
Fees:

1 User $25.00 _______ ________

5 Users $100.00 _______ ________

25 Users $400.00 _______ ________

50 Users $700.00 _______ ________

100 Users $1,000.00 _______ ________

Unlimited U.S. Only Site License $2,000.00 _______ ________

Unlimited Worldwide Site License $3,000.00 _______ ________

2. Name: ________________________________________________________________

3. Address: ________________________________________________________________

4. City: ________________________________________________________________

5. State/Province: ________________________________________________________________

6. Postal Code: ________________________________________________________________

7. Country: ________________________________________________________________

8. E-mail Address: ________________________________________________________________

9. Current version number of Password Tracker Deluxe: Version 3.50

10. Where did you find out about Password Tracker Deluxe?
[    ] C|Net Download.com [    ] Danworld.com
[    ] Galt Shareware Zone [    ] Harris’ Hanger95
[    ] MyDesktop.com [    ] Oh Yeah!USA
[    ] Password Tracker Deluxe Home Page [    ] SlaughterHouse
[    ] SoftSeek [    ] TUCOWS
[    ] Winfiles.com (Windows95.com) [    ] ZDNet Software Library
[    ] Other: ________________________________________________________________

11. Any enhancements to Password Tracker Deluxe you would like to see (optional):

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

Send to: Robert P. Cannalte
P.O. Box 7331
Algonquin, IL 60102-7331
USA



Password dialog box

Enter the required password to proceed.



Properties page (P-Track dialog box)

The following options set the properties of the P-Track:
Name

The name of the account or program.
Shortcut

The shortcut to run or URL to go to when selecting the P-Track.    To enter a shortcut, simply drag 
and drop the shortcut from the desktop or from explorer.    To enter a URL, copy and paste the URL 
from your browser.

User ID
The user id of the account.

Password
The password of the account or program.

Verify Password
Re-enter the password to verify that it was typed correctly.

Generate
Choose this button to automatically generate a password.    Use the Generate Password dialog box 
to change how the password is generated.

Window Title
The playback window title bar text to send the keystrokes to.
To do a wild card character match, put an asterisk (*) at the beginning or the end of the title bar text.   
For example: “Enter*” or “*Password”.    Be careful using the wild card character match since it may 
cause the automatic send to be run at the wrong times.
Enter an asterisk (*) if you want to send the keystrokes to the last active window.
If you do not wish to send the password to the program, leave the window title blank.
See also: P-Track Wizard - Playback Window Title Bar Text

Select
Choose this button to enter the playback window title text by selecting the window title bar with the 
left mouse button.

Send Keystrokes
The sequence of keystrokes to send the user id and/or password to the program.
See also: P-Track Wizard - Keystroke Sequence

Custom
Choose this button for additional assistance in creating a custom keystroke sequence using the 
Custom Keystroke Sequence dialog box.

See Also:
Notes page
Preferences page
Synchronize page



Notes page (P-Track dialog box)

Each P-Track can contain individual notes.

Enter the notes in the edit box.

Hint: The notes can contain a key phrase to help you remember the password.

See Also:
Properties page
Preferences page
Synchronize page



Preferences page (P-Track dialog box)

The following options set the individual preferences of the P-Track:
Password never expires

If checked, this password never expires.
Password expires every n days

If checked, this password expires in the number of days entered.
Add to system tray pop-up menu

If checked, this P-Track will be added to the system tray pop-up menu.
Enable automatic send during scan for playback windows

If checked, the P-Track’s keystrokes are automatically sent if it’s playback window appears.
Match parent window title bar text to send

If checked, the parent window of the playback window must match the internally saved text to 
automatically send this P-Track.    The internal parent window title bar text to match is saved every 
time the P-Track is sent.    Therefore, send the P-Track manually to store the parent window title bar 
text.

Match window text to send
If checked, the additional text on the playback window must match the internally saved text to 
automatically send this P-Track.    The internal window text to match is saved every time the P-Track 
is sent.    Therefore, send the P-Track manually to store the window text.

Web Browser
Select the web browser to use when opening URLs.

Open in a new window
If checked, open the URL in a new window using the selected browser.    The default system browser
cannot be opened in a new window.

See Also:
Properties page
Notes page
Synchronize page
Scan For Playback Windows Help



Synchronize page (P-Track dialog box)

The following options set the synchronize properties of the P-Track:
Synchronize this password with other P-Tracks

When using the Change Password command, the listed P-Track’s passwords will also be changed.
Add

Choose this button to add a new P-Track to synchronize with.
Delete

Choose this button to delete the selected P-Track from the synchronize list.

See Also:
Properties page
Notes page
Preferences page



Password dialog box

The following options allow access to your Tracking List.    If a Tracking List password is entered, the 
password will need to be entered to open the Tracking List file.
Old Password

The old password to change.
New Password

The new password.    If blank, password protection of the Tracking List will be disabled.
Verify

Re-enter the new password to verify that you typed the password correctly.
Password required to send keystrokes

If checked, the Tracking List password will need to be entered to send keystrokes to a playback 
window.

Note: Be sure to write the Tracking List password down somewhere in a secure place.    We are unable 
to recover your Tracking List should you forget this password.



Options dialog box

The following Tracking List options can be set:
Passwords never expire

If checked, passwords never expire.
Passwords expire

The number of days the passwords will expire in.



Password command (File menu)

Use this command to allow access to your Tracking List.

If you have the Use Wizards preference turned on, the Tracking List Wizard will guide you through 
changing the Tracking List password.    Otherwise, the Password dialog box will be used to change the 
Tracking List password.

Note: Be sure to write the Tracking List password down somewhere in a secure place.    We are unable 
to recover your Tracking List should you forget this password.



Options command (File menu)

Use this command to change the options of the Tracking List.

If you have the Use Wizards preference turned on, the Tracking List Wizard will guide you through 
modifying the Tracking List options.    Otherwise, the Options dialog box will be used to change the 
Tracking List options.



Add command (Edit menu)

Use this command to add a new P-Track to the Tracking List.

If you have the Use Wizards preference turned on, the P-Track Wizard will guide you through adding a 
new P-Track.    Otherwise, the P-Track dialog box will be used to add a new P-Track.

Shortcuts

Toolbar:
Keys: CTRL+A



Delete command (Edit menu)

Use this command to delete the selected P-Tracks from the Tracking List.    You will be asked to confirm 
deleting the selected P-Tracks.

If the Tracking List is password protected, you will be asked for the Tracking List password to delete the 
selected P-Tracks.

Shortcut

Toolbar:
Keys: DELETE



Properties command (Edit menu)

Use this command to change the properties of the selected P-Track.

If you have the Use Wizards preference turned on, the P-Track Wizard will guide you through modifying 
the P-Track.    Otherwise, the Properties dialog box will be used to modify the P-Track.

If the Tracking List is password protected, you will be asked for the Tracking List password to modify the 
properties of the selected P-Track.

Shortcuts

Toolbar:
Keys: ALT+ENTER



Passwords command (View menu)

Use this command to show or hide the display of the passwords and expiration dates.    The expiration 
dates will only be displayed if passwords are set to expire.

If the Tracking List is password protected, you will be asked for the Tracking List password to turn the 
display of the Passwords back on.

See Also
Options command



User IDs command (View menu)

Use this command to show or hide the display of the user ids.

If the Tracking List is password protected, you will be asked for the Tracking List password to turn the 
display of the User IDs back on.



Help Topics command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Password Tracker Deluxe and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.

Shortcut

Toolbar:
Keys: F1



Send command (Edit menu)

Use this command to send the user id, password or notes to the playback window.

Shortcut

Toolbar:
Keys: CTRL+E



License Agreement

Carefully read the terms and conditions before using Password Tracker Deluxe.    By using Password 
Tracker Deluxe, you agree to the terms and conditions stated.    If you do not agree to the stated terms 
and conditions, do not use Password Tracker Deluxe.

Password Tracker Deluxe is Shareware, not public domain software or free software.

Unregistered users are granted a limited license to evaluate Password Tracker Deluxe for 30 days.    The
use of Password Tracker Deluxe after the 30 day evaluation period requires registration and is in 
violation of federal copyright laws.

One registered copy of Password Tracker Deluxe may be licensed to one person for use on multiple 
machines or for one machine for use by multiple people.    Password Tracker Deluxe may be used on a 
network provided that all workstations that have access have individual licenses.

Password Tracker Deluxe is registered when the registration fee has been received and a registration 
number has been issued.    It is unlawful to distribute the registration number to anyone.

Password Tracker Deluxe and its associated files cannot be modified or patched in any way including 
but not limited to decompiling, disassembling or reverse engineering the files.

A limited license is granted to distribute Password Tracker Deluxe for evaluation purposes only under 
the following conditions:
1. All the files must be distributed together in unmodified form.
2. No fee, charge, donation or other compensation can be accepted or requested, except as authorized

below.
a. Electronic bulletin board and internet site system operators may make Password Tracker Deluxe 

available for downloading as long as the above conditions are met and there is not a specific 
charge for downloading Password Tracker Deluxe.    A charge for the overall use of the bulletin 
board system or internet site is permitted.

b. Vendors of user-supported or shareware software and non-profit user groups may distribute 
Password Tracker Deluxe as long as the above conditions are met.    A charge for disk duplication
and handling of Password Tracker Deluxe is permitted provided, that when pro-rated, is not more
than five dollars US.

A letter stating that you are distributing Password Tracker Deluxe is recommended so as updates 
can be provided.

Limited Warranty
THE PASSWORD TRACKER DELUXE SOFTWARE AND ACCOMPANYING FILES ARE PROVIDED 
"AS IS" AND WITHOUT WARRANTIES AS TO THE PERFORMANCE OF MERCHANTABILITY OR ANY
OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.    BECAUSE OF THE VARIOUS 
HARDWARE AND SOFTWARE OPERATING ENVIRONMENTS, NO WARRANTY FOR A PARTICULAR
PURPOSE IS OFFERED.    IN NO EVENT SHALL CARL L. ROTH OR ROBERT P. CANNALTE BE 
LIABLE FOR ANY DAMAGES WHATSOEVER ARISING OUT OF THE USE OR INABILITY TO USE 
PASSWORD TRACKER DELUXE EVEN IF CARL L. ROTH OR ROBERT P. CANNALTE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.



Exit Password Tracker Deluxe dialog box

Your passwords will not be easily accessible if Password Tracker Deluxe closes.    You should select to 
minimize Password Tracker Deluxe.

The following options are available when trying to exit Password Tracker Deluxe:
Exit

Choose this button to close Password Tracker Deluxe.
Minimize

Choose this button to minimize Password Tracker Deluxe.    This option is disabled if the stay on top 
preference is on.

Cancel
Choose this button to return back to Password Tracker Deluxe.



P-Track Wizard - Name

Tracking Lists can store an unlimited number of P-Tracks.    Each P-Track can hold various pieces of 
information including a name, a user id/user name, and a password.

Enter the name of the P-Track in the edit box.

Hint: It's most useful to create a brief name that relates to the program or service that the P-Track will 
remember.    Your P-Track name can be later changed at any time by selecting the Properties command.

These buttons are available to navigate the Wizard:
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - Playback Window Title Bar Text

One of the most exciting features of Password Tracker Deluxe is its ability to automatically send the user
id and/or password to the program or service that requires your input.    To do this, the P-Track must 
store the text in the Title Bar of the Playback Window which is asking for the user id and/or password.

If the Playback Window to send the user id and/or password to is currently open on your screen, choose
the “Select Playback Window” button.    Then, simply click the left mouse button on the Title Bar of the 
Playback Window.    This is the recommended method.

You may also manually enter the Title Bar Text in the edit box.    Be sure to enter the text EXACTLY as it 
appears in the Title Bar of the Playback Window.

To do a wild card character match, put an asterisk (*) at the beginning or the end of the Title Bar Text.    
For example: “Enter*” or “*Password”.    Be careful using the wild card character match since it may 
cause the automatic send to be run at the wrong times.

You may also enter an asterisk (*) for the Title Bar Text to have Password Tracker Deluxe send the user 
id and/or password to the last active window.

If you do not wish to have Password Tracker Deluxe send the user id and/or password to a Playback 
Window, leave the Title Bar Text blank.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
Invalid playback window title
Password Tracker Deluxe timed-out waiting for playback window
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - Keystroke Sequence

In order to automatically send your user id and/or password to the Playback Window, Password Tracker 
Deluxe will need you to tell it the sequence of keystrokes that are necessary to send the information.

Select the sequence of keystrokes from the list.

If you are an advanced user, and would like to enter your own custom keystroke sequence, choose the 
“Custom” button.    You can then enter the custom keystroke sequence using the Custom Keystroke 
Sequence dialog box.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
Special Codes
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Notes
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - User ID

P-Tracks can also store a user id or user name if the program or service requires one with the password.
If no user id or user name is required, just choose the “Next” button.

Enter the user id or user name in the edit box.

Hint: Be sure to type the user id or user name exactly as you did when you created it, making sure to 
use upper and lower case letters as necessary.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - Password

Enter the password in the first edit box.

Re-enter the password in the second edit box exactly as you entered it before to verify that is was typed 
in correctly.

Hint: Be sure to type the password exactly as you did when you created it, making sure to use upper 
and lower case letters as necessary.

Generate
Choose this button to automatically generate a password.    Use the Generate Password dialog box 
to change how the password is generated.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - Notes

Each P-Track can contain individual notes.

Enter the notes in the edit box.

Hint: The notes can contain a key phrase to help you remember the password.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - Shortcut

Each P-Track can contain a shortcut to run before sending the user id and/or password.    The shortcut 
can be a Windows shortcut link file, a command line or a URL.

Enter the shortcut in the edit box.

Hint: To enter a shortcut link, simply drag and drop the shortcut from your desktop or Explorer to the edit 
box.

Hint: To enter a URL, copy and paste the URL text from your browser.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Name
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Preferences
P-Track Wizard - Congratulations!



P-Track Wizard - Preferences

The following options set the individual preferences of the P-Track:
Password never expires

If checked, this password never expires.
Add to system tray pop-up menu

If checked, this P-Track will be added to the system tray pop-up menu.
Enable automatic send during scan for playback windows

If checked, the P-Track’s keystrokes are automatically sent if it’s playback window appears.
Web Browser

Select the web browser to use when opening URLs.
Open in a new window

If checked, open the URL in a new window using the selected browser.    The default system browser
cannot be opened in a new window.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the P-Track and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Congratulations!
Scan For Playback Windows Help



P-Track Wizard - Congratulations!

Verify the summary of information for the P-Track.    Then, choose one of the following buttons:
Back

Choose this button to go back to the previous page.
Finish

Choose this button to save the P-Track.
Cancel

Choose this button to not save the P-Track.
Help

Choose this button to view this online help.

See Also:
P-Track Wizard - Name
P-Track Wizard - Shortcut
P-Track Wizard - User ID
P-Track Wizard - Password
P-Track Wizard - Playback Window Title Bar Text
P-Track Wizard - Keystroke Sequence
P-Track Wizard - Notes
P-Track Wizard - Preferences



Tracking List Wizard - Name

Password Tracker Deluxe can be used by one or more users.    For this reason, each user must create 
his or her own list, called a "Tracking List".    Tracking Lists can store information about an unlimited 
number of passwords in records, called "P-Tracks".

Enter a name for the Tracking List in the edit box.

Note: Tracking Lists are stored as individual files in the Password Tracker Deluxe directory created 
during setup.

These buttons are available to navigate the Wizard:
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the Tracking List and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
Tracking List Wizard - Password Protect?
Tracking List Wizard - Old Password
Tracking List Wizard - Password
Tracking List Wizard - Password Required To Send Keystrokes
Tracking List Wizard - Password Expiration Dates
Tracking List Wizard - Congratulations!



Tracking List Wizard - Password Protect?

Tracking Lists can be individually protected with their own passwords.    This feature is useful when more
than one person has access to your Tracking List.

Select either Yes or No to protect the Tracking List with a password.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the Tracking List and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
Tracking List Wizard - Name
Tracking List Wizard - Password
Tracking List Wizard - Old Password
Tracking List Wizard - Password Required To Send Keystrokes
Tracking List Wizard - Password Expiration Dates
Tracking List Wizard - Congratulations!



Tracking List Wizard - Password

Enter the password to protect the Tracking List in the first edit box.

Re-enter the password in the second edit box exactly as you entered it before to verify that is was typed 
in correctly.

Note: This will be the only password you need to remember.    You will be required to enter it each time 
you open the Tracking List.    Be sure to store a copy of this password in a safe place.    You can disable 
the password protection for the Tracking List later by using the Password command on the File menu.

These buttons are available to navigate the Wizard:
Back

Choose this button to go back to the previous page.
Next

Choose this button to go to the next page.
Cancel

Choose this button to not save the Tracking List and quit the Wizard.
Help

Choose this button to view this online help.

See Also:
Tracking List Wizard - Name
Tracking List Wizard - Password Protect?
Tracking List Wizard - Old Password
Tracking List Wizard - Password Required To Send Keystrokes
Tracking List Wizard - Password Expiration Dates
Tracking List Wizard - Congratulations!



Tracking List Wizard - Congratulations!

Verify the summary of information for the Tracking List.    Then, choose one of the following buttons:
Back

Choose this button to go back to the previous page.
Finish

Choose this button to save the Tracking List.
Cancel

Choose this button to not save the Tracking List.
Help

Choose this button to view this online help.

See Also:
Tracking List Wizard - Name
Tracking List Wizard - Password Protect?
Tracking List Wizard - Old Password
Tracking List Wizard - Password
Tracking List Wizard - Password Required To Send Keystrokes
Tracking List Wizard - Password Expiration Dates



Tracking List Wizard - Password Required To Send Keystrokes

If you are password protecting the Tracking List, you have the additional security option of requiring the 
Tracking List Password to be entered before a user id and/or password is sent to the Playback Window.

This additional level of security is useful if your computer is left unattended.

Select either Yes or No to require the Tracking List Password to be entered in order to send the user id 
and/or password to the Playback Window.

Back
Choose this button to go back to the previous page.

Next
Choose this button to go to the next page.

Cancel
Choose this button to not save the Tracking List and quit the Wizard.

Help
Choose this button to view this online help.

See Also:
Tracking List Wizard - Name
Tracking List Wizard - Password Protect?
Tracking List Wizard - Old Password
Tracking List Wizard - Password
Tracking List Wizard - Password Expiration Dates
Tracking List Wizard - Congratulations!



Tracking List Wizard - Password Expiration Dates

Password Tracker Deluxe has the ability to notify you when your passwords expire.    By regularly 
changing your passwords, your accounts will become more secure.

Select either Yes or No to be notified when your passwords expire.

If you want to be notified when your passwords expire, enter the number of days the passwords will 
expire in.    Type in the number of days or use the up and down arrows to select the number of days.

Hint: It is recommended to change your passwords every 30 days.

Back
Choose this button to go back to the previous page.

Next
Choose this button to go to the next page.

Cancel
Choose this button to not save the Tracking List and quit the Wizard.

Help
Choose this button to view this online help.

See Also:
Tracking List Wizard - Name
Tracking List Wizard - Password Protect?
Tracking List Wizard - Old Password
Tracking List Wizard - Password
Tracking List Wizard - Password Required To Send Keystrokes
Tracking List Wizard - Congratulations!



Tracking List Wizard - Old Password

In order for you to change the password or turn off protection for a Tracking List, you must enter the old 
password.

Enter the old password in the edit box.

Back
Choose this button to go back to the previous page.

Next
Choose this button to go to the next page.

Cancel
Choose this button to not save the Tracking List and quit the Wizard.

Help
Choose this button to view this online help.

See Also:
Tracking List Wizard - Name
Tracking List Wizard - Password Protect?
Tracking List Wizard - Password
Tracking List Wizard - Password Required To Send Keystrokes
Tracking List Wizard - Password Expiration Dates
Tracking List Wizard - Congratulations!



Registration Number dialog box

The following options must have valid entries to register Password Tracker Deluxe.    Enter the name 
and registration number exactly as provided to you.
Name

The name of the person registering the program.
Registration Number

Your valid registration number.



Registration Number command (Help menu)

Use this command to register your copy of Password Tracker Deluxe.    Use the Registration dialog box 
to enter your registration information.



Custom Keystroke Sequence dialog box

The following options allow you to customize the send keystroke sequence.
Enter a custom keystroke sequence

The sequence of keystrokes to send to the playback window.    See also: Special Codes
Special Codes Help

Choose this button to read the special codes online help.
Get Control Class Name

Choose this button to use the mouse to select a control to get it’s class name.    Use the left mouse 
button to select the control.



Notes command (Edit menu)

Use this command the edit the P-Track notes.    The P-Track dialog box Notes page will be used to edit 
the P-Track notes.

If the Tracking List is password protected, you will be asked for the Tracking List password to edit the P-
Track notes.

Shortcuts

Toolbar:
Keys: CTRL+M



Notes command (View menu)

Use this command to show or hide the display of the first line of the notes.

If the Tracking List is password protected, you will be asked for the Tracking List password to turn the 
display of the Notes back on.



Favorite P-Track command (System Tray menu)

Use this command to send the selected P-Track's user id, password and notes to a playback window.    If
the playback window is not found or not defined, the P-Track’s shortcut is run.



Special Codes

Special codes for sending keystrokes to a playback window are:
{userid} Send the user id.    The current text in the edit control is automatically 

selected unless a {noselectall} code precedes this code.
{password} Send the password.    The current text in the edit control is automatically 

selected unless a {noselectall} code precedes this code.
{password!} Send the password only to a password styled edit control.    The current text 

in the edit control is automatically selected unless a {noselectall} code 
precedes this code.

{notes} Send the notes.
{tab n} Send the tab key n times.
{enter n} Send the enter key n times.
{escape n} Send the escape key n times.
{space n} Send the space bar key n times.
{Fi} Send the function key i.    The keys F1 to F24 can be sent.    For example: 

{F7}.
{pause s} Pause s seconds before sending the next keystroke.    For example: {pause 

2.5} will pause 2.5 seconds.
{home n} Send the home key n times.
{end n} Send the end key n times.
{left n} Send the left arrow key n times.
{right n} Send the right arrow key n times.
{up n} Send the up arrow key n times.
{down n} Send the down arrow key n times.
{pageup n} Send the page up key n times.
{pagedown n} Send the page down key n times.
{backspace n} Send the back space key n times.
{delete n} Send the delete key n times.
{insert n} Send the insert key n times.
{backtab n} Send the back tab key (shift+tab) n times.
{selectall} Select all the text in the edit control.
{edit x} Go to the xth edit control.    For example: {edit 2} will go to the second edit 

control.    This code does not work with Microsoft Internet Explorer 4 or 
Microsoft Windows 98.

{tabstop x} Go to the xth control.    For example: {tabstop 2} will go to the second 
tabstopped control.    This code does not work with Microsoft Internet 
Explorer 4 or Microsoft Windows 98.

{control c x} Go to the xth control with the class name c.    Use the Get Control Class 
Name command to get the control’s class name.    For example: {control edit 
2} will go to the second control with the class name edit.    This code does not
work with Microsoft Internet Explorer 4 or Microsoft Windows 98.

{nofindedit} Skip automatically finding the first edit control at the beginning of the 
sequence.

{noselectall} For the next {userid} or {password} code, do not automatically select all the 
text.

{clipboard userid} Put the user id on the clipboard to be pasted into another program by 
pressing Ctrl+V.    Choose the “Continue” button to clear the clipboard and 
continue processing the send keystrokes sequence.

{clipboard password} Put the password on the clipboard to be pasted into another program by 
pressing Ctrl+V.    Choose the “Continue” button to clear the clipboard and 
continue processing the send keystrokes sequence.



{clipboard notes} Put the notes on the clipboard to be pasted into another program by pressing
Ctrl+V.    Choose the “Continue” button to clear the clipboard and continue 
processing the send keystrokes sequence.

{ctrl} The next keystroke sent will also have the control key pressed.    For 
example: {ctrl}v will paste in the current clipboard contents.    It is possible to 
combine the {alt} and {shift} codes.

{alt} The next keystroke sent will also have the alt key pressed.    For example: 
{alt}fo will pop-up the file menu and start the open command.

{shift} The next keystroke sent will also have the shift key pressed.    For example: 
{shift}a will send a capital A.

{ctrlkey n} Send the control key n times.    The control key will be pressed and released 
without any other keys pressed.

{altkey n} Send the alt key n times.    The alt key will be pressed and released without 
any other keys pressed.

{shiftkey n} Send the shift key n times.    The shift key will be pressed and released 
without any other keys pressed.

{pausekey n} Send the pause/break key n times.
{noedit} Obsolete.    Works exactly like {nofindedit}.

To send other characters, do not put brackets around the text to send.    For example: {userid}{tab}this 
text is sent as is{tab}{password}{enter}.

An {edit} code is automatically run as the first sequence unless an {edit}, {nofindedit}, {control}, {tabstop}
or {clipboard} code is first.    For example: {edit}{password}{enter} is exactly the same thing as 
{password}{enter}.

If none of the default send keystroke sequences work, an easy way to figure out what sequence of 
codes to use is to use the keyboard to enter the information.    Right after the window opens, write down 
every key pressed.    Then, substitute the correct code for the keys you typed.    For example, at every 
point you pressed the tab key, enter the code {tab}.    Do not use the mouse at any time when using the 
method.

If information is going to the wrong edit controls on the window, add or delete extra {tab} codes before 
the {userid}, {password}, or {notes} code.    For example: use {userid}{tab}{tab}{password}{enter} to skip 
passed the control right before the password entry edit control.

Examples:
To send the user id and password to a dialog box:

{userid}{tab}{password}{enter}
To send the user id and password to a form on a web page:

{userid}{tab}{password}{tab}{space}
To send the user id to the first dialog box then the password to a second dialog box:

{userid}{enter}{pause 1}{password}{enter}
To send the user id and password to a text based program like a terminal emulator or telnet:

{nofindedit}{noselectall}{userid}{enter}{pause 5}{noselectall}{password}{enter}
To only send the password to a dialog box:

{password}{enter}
To send the notes to any edit control:

{nofindedit}{notes}
To use the clipboard to copy the user id and password to a program:

{clipboard userid}{clipboard password}



See also:
Timeout: The control was not found
The control is not a password style edit control



Shortcuts command (View menu)

Use this command to show or hide the display of the shortcuts.



Generate Password dialog box

The following options allow you to generate a new password:
Method

Select one of the generation methods.

Random Letters and Numbers: this method generates an 8 to 12 character password consisting
of random letters and numbers.    Choose the Options button to set the minimum and maximum number of
characters in the password.

Simple: this method randomly chooses two words from the list and separates them with a dash.

Complex: this method randomly chooses two words from the list.    Between the two words and at
the end, a number between 0 and 99 may be added.    The case of the letters is randomly changed.

Options
Choose this button to change the options for generating a password with random letters and 
numbers using the Random Password Options dialog box..

Word List
Choose this button to change the list of words used to generate the simple and complex passwords.  
Use the Word List dialog box to change the list of words.

The new password is placed on the clipboard.    Press Ctrl+V to insert the new password in the other 
program.    The clipboard will be cleared after closing this dialog box.



Word List dialog box

The following options allow you to modify the word list for generating a simple or complex password:
Add

Choose this button to add a new word to the list.
Delete

Choose this button to delete the selected word from the list.

To modify an existing word, click on a selected word to go into edit mode.



Scan for Playback Windows command (System Tray menu)

Use this command to check and see if the foreground window is a playback window.    If the foreground 
window is a playback window, automatically send the user id and/or password.    A check mark is 
displayed next to the command if this feature is enabled.

See Also:
Scan for Playback Windows Help



Send Keystrokes dialog box

Continue
If enabled, choose this button to continue the send keystrokes process.
If the user id, password or notes is on the clipboard, press Ctrl+V to paste the text into another 
program.    Then, choose the “Continue” button.
If Password Tracker Deluxe is finding a control, place the cursor on the appropriate control then 
choose the “Continue” button.

Cancel
Choose this button to stop the send keystrokes process.



Error: Invalid playback window title

The current foreground window title bar text does not match the playback window title bar text entered 
for this P-Track.

Here are some tips to help solve this problem:

When entering the Playback Window Title Bar Text, use the Select Playback Window button to 
automatically enter the correct text for you.    Edit the P-Track’s properties and when entering the 
Playback Window Title Bar Text, choose the “Select Playback Window” button.    Then, select the 
Playback Window Title Bar with the left mouse key.

Sometimes the displayed title bar text does not match the text that Windows stores for the 
window.    In this case, you must use the Select Playback Window button.

If the Playback Window Title Bar Text is not always the same, you can use the asterisk (*) wild 
card character at either the beginning or the end of the title bar text.

When using the wild card character, be sure to include as many common characters as possible.

Make sure you have selected the correct P-Track to send.

If you are still having problems, send an e-mail to ptd@bigfoot.com.



Preferences command (View menu)

Use this command to set the program preferences.    Use the Preferences dialog box to set the 
preferences.

See Also:
General page
System Tray Menu page



System Tray Menu page (Preferences dialog box)

The following program options can be set on the System Tray Menu preferences page:
Maximum number of P-Tracks to list

Enter the maximum number of most recently used P-Tracks to list on the system tray pop-up menu.
Sort

Select the system tray pop-up menu sort option from the list.
Show P-Track icons on menu

If checked, the P-Track icons are shown on the system tray pop-up menu.
System tray icon file name

Enter the file name of an icon file (.ico) to use as the System Tray icon.    If this is left blank, or the 
icon file cannot be loaded, the default icon will be used.

See Also:
General page



General page (Preferences dialog box)

The following program options can be set on the General preferences page:
Use Wizards

If checked, use the Wizards to create or modify Tracking Lists and P-Tracks.
Stay On Top

If checked, Password Tracker Deluxe will stay visible on top of all other windows.
Scan for playback windows

If checked, Password Tracker Deluxe automatically checks to see if the foreground window is a 
playback window.    If the foreground window is a playback window, automatically send the user id 
and/or password.

Pause before auto-send
Enter the amount of time, in seconds, to pause before automatically sending a user id and/or 
password to a playback window.

Confirm exiting Password Tracker Deluxe
If checked, when closing Password Tracker Deluxe, confirm that you want to exit the program as 
opposed to just minimizing the window.

Register Password Tracker Deluxe with the Windows Shell
If checked, every time Password Tracker Deluxe starts, it will register itself with the Windows Shell.    
It is not recommended to turn this option off unless you have changed how the Windows Shell 
interacts with Tracking Lists.    For example, turn this option off if you removed the Password Tracker 
Deluxe Tracking List item from the Windows Explorer right-clicked New pop-up menu.    Turn this 
option off before you change the Windows Shell interface.

Ask to backup
If checked, Password Tracker Deluxe will automatically ask you to backup the active tracking list.    
Enter the number of days between backups in the edit control.

Use Windows encryption to store Tracking Lists
If checked, Password Tracker Deluxe will use the Windows encryption algorithms to encrypt and 
decrypt the Tracking List files.    With this option on, Tracking Lists are even more secure.    You will 
need to be using Windows 95 B (OSR 2), Windows 98, Windows NT or have Internet Explorer 3 or 
above installed on your computer in order for this option to be enabled.
When turning this option on, it is recommened to make a backup copy of all your Tracking List files in
case there is a problem using the Windows encryption scheme.

Play Sounds
If checked, Password Tracker Deluxe will play a sound to notify you when it will automatically send a 
P-Track or ask to backup the Tracking List.

See Also:
System Tray Menu page
Scan For Playback Windows Help



Restore command (System Tray menu)

Use this command to restore the main Password Tracker Deluxe window from the system tray.



Error: Password Tracker Deluxe timed-out waiting for playback window

The playback window did not open after running the P-Track shortcut.    Password Tracker Deluxe stops 
waiting for the playback window to appear after 60 seconds has elapsed.

There are two reasons why this happened:
1. The playback window never did actually appear.
2. The playback window title bar text is not correct.    For additional help on making sure the playback 

window title bar text is correct, read the help for Invalid playback window title.

If you are still having problems, send an e-mail to ptd@bigfoot.com.



Error: The control is not a password style edit control

The control that Password Tracker Deluxe is trying to send the password to is not a password style edit 
control.    A password style edit control is one that displays asterisks (*) in place of the actual characters 
typed.

There are two different ways to correct this problem:
1. Make sure the cursor is placed on the correct edit control.    Add extra {tab} send keystroke codes 

before the {password!} code to move the cursor to the correct edit control.
or
2. Use the send keystrokes code {password} instead.

If you are still having problems, send an e-mail to ptd@bigfoot.com.



Error: Timeout: The control was not found

Password Tracker Deluxe was unable to find the given control on the current window.    After 60 
seconds, Password Tracker Deluxe stops searching for the control.

Here are a few reasons why this error occurs:
1. The class name of the control Password Tracker Deluxe is trying to find is not correct.

Every Windows control has a class name associated with it.    Each type of Windows control belongs 
to a different class name.    For example, the standard edit control has the class name “Edit” while 
the standard button control has the class name “Button”.
The send sequence code {edit} searches for default edit control class names.    If one of these 
default edit controls is not found, this error message will appear.
An {edit} code is automatically run as the first sequence unless an {edit}, {nofindedit}, {control}, 
{tabstop} or {clipboard} code is first.    For example: {edit}{password}{enter} is exactly the same thing 
as {password}{enter}.
There are two different ways to solve this problem.
a. The simplest way is to begin the send keystrokes sequence with {nofindedit}.    This will skip 

finding one of the default edit controls.
b. The other way is to specify the class name to find by using the {control} send sequence code.    

This special code has the syntax {control c x} where ‘c’ is the class name of the control and ‘x’ is 
the order number.    You can find the class name of the control by using the Get Control Class 
Name button on the Custom Send Keystrokes dialog box, then select the control with the left 
mouse key.

Note: if the P-Track is for a form on a web page and you entered a shortcut for the P-Track or you 
have the scan for automatic playback windows option turned on, you must implement option b.    This
is because web pages don’t always download at the same speed every time and the cursor is not 
always on the correct control.

2. The control order number is incorrect.    To correct this problem, change the number in the send 
sequence code to a lower number.    One way to figure out what number the control is, is to count the
number of times you press the tab key to get to the control after the window first opens up.

3. The web page still hasn’t been completely downloaded from the web site.    Just manually send the 
P-Track when the page is finally displayed.

4. If you are using Microsoft Internet Explorer 4 or Windows 98, the edit controls on web page forms 
are not individual controls.    Therefore, the edit controls cannot be found.    Just place the cursor in 
the correct edit control and choose the “Continue” button.

An alternative to adjusting the send keystroke sequence is to place the cursor in the correct edit control 
and choose the “Continue” button.

If you are still having problems, send an e-mail to ptd@bigfoot.com.



Copy User ID to Clipboard command (Edit menu)

Use this command to copy the user id to the Windows clipboard.    Press Ctrl+V to insert the user id in 
another program.    The clipboard will be cleared after closing the dialog box.

Shortcuts

Toolbar:
Keys: CTRL+U



Copy Password to Clipboard command (Edit menu)

Use this command to copy the password to the Windows clipboard.    Press Ctrl+V to insert the 
password in another program.    The clipboard will be cleared after closing the dialog box.

Shortcuts

Toolbar:
Keys: CTRL+W



Copy Notes to Clipboard command (Edit menu)

Use this command to copy the notes to the Windows clipboard.    Press Ctrl+V to insert the notes in 
another program.    The clipboard will be cleared after closing the dialog box.

Shortcuts

Toolbar:
Keys: CTRL+O



Stay On Top command (System Tray menu)

Use this command to enable or disable Password Tracker Deluxe to stay visible on top of all other 
windows.    A check mark is displayed next to the command if the stay on top feature is enabled.



System Tray menu commands

The System Tray menu offers the following commands:

Favorite P-Tracks Launch the shortcut and send the user id, password and notes.
Add New P-Track Adds a new P-Track.
Preferences: 
Stay On Top

Set Password Tracker Deluxe as a top level window.

Preferences: 
Scan For 
Playback 
Windows

Scan the foreground windows for playback windows.

Restore Restore program.
Exit Exits Password Tracker Deluxe.

Scan for Playback Windows Help

If P-Tracks are being sent when they shouldn’t be, try one of these tips:
a. Turn off the scan for playback windows feature.    No P-Tracks will ever be automatically sent.
b. Individually disable the P-Track automatic send that is causing the problem by using the Properties 

command and disabling automatic send during scan for playback windows on the Preferences page.

If P-Tracks are not being sent when they should be, try these tips:
1. Manually send the P-Track so additional information can be stored.
2. Turn on the preference to additionally match the playback window text.    To turn on this preference, 

use the Properties command and enable match window text on the Preferences page.    This is an 
advanced feature and is not available if the Wizards are turned on.

3. If tip 2 did not work, try disabling the match parent window title bar while keeping the match window 
text enabled.

4. P-Tracks with the playback window title bar text set to “*” will never be automatically sent.    Enter the
correct playback window title bar text to solve this problem.

P-Tracks for web pages that contain frames should disable the automatic send during scan for playback 
windows since the title bar text of the browser does not change while navigating around the site.

A P-Track must be sent manually at least once for Password Tracker Deluxe to record additional 
information to distinguish itself from other P-Tracks with the same playback window title bar text.

If you are still having problems, send an e-mail to ptd@bigfoot.com.



Backup command (File menu)

Use this command to backup the active Tracking List.    Since your passwords are very important, it is a 
good idea to regularly backup your Tracking List.    A backup ensures that you have a copy of your 
passwords in case your Tracking List is erased or damaged.

In order to be able to recover your Tracking List in case of a system crash, the Windows encryption 
algorithms will not be used for the backup files. The standard encryption algorithms will be used instead.

A good practice for backing up your Tracking List is to alternate between 2 different floppy disks.    That 
way, you have an extra backup in case the floppy disk gets damaged.    You can write the date of the 
backup on the label to know which disk is older.

Please be sure to store all backup diskettes in a secure location.

Note: The backup copy of the Tracking List uses exactly the same Tracking List password.    If the 
Tracking List is not password protected, the backup copy won’t be either.



Check for an Update command (Help menu)

Use this command to check for an update to Password Tracker Deluxe on the Internet.

If connecting to the Internet using a proxy server that requires authentication, the Check for an Update 
command will use the user id and password from a P-Track named “Proxy Server”.    When entering the 
proxy server user name and password, you are given the option to save the user name and password in
a P-Track named “Proxy Server”.    If the “Proxy Server” P-Track does not exist, it will be added.    You 
can safely change the properties of the “Proxy Server” P-Track to automatically send the password to 
your browser’s authentication dialog box.

Thanks to Andrew Reeves-Hall for helping test the proxy server authentication.



Random Password Options dialog box

The following options allow you to select how the random letters and numbers password gets generated:
Minimum number of characters

Enter the minimum number of characters for the password.
Maximum number of characters

Enter the maximum number of characters for the password.



Registration Information command (Help menu)

Use this command to view the Registration Information.



Register Online command (Help menu)

Use this command to register your copy of Password Tracker Deluxe online using the Internet.    Your 
default browser will be launched to view information on registering Password Tracker Deluxe online.

Before selecting this command, make sure you are already connected to the Internet.



Equally Space Columns command (View menu)

Use this command to equally space the visible columns.    You can also double click the empty space on 
the column headings.



Year 2000 Compliance

Carl L. Roth
P.O. Box 7331
Algonquin, IL 60102-7331
USA

June 8, 1998

RE: Password Tracker Deluxe Year 2000 Compliance

Dear Password Tracker Deluxe User,

Password Tracker Deluxe Version 3.0 and above is year 2000 compliant. The program uses the 
standard Microsoft Visual C++ compiler time and date functions to perform all time and date 
calculations. The program passed all internal tests on a machine set to the year 2000. The time and date
aspects of the program that were tested were the password expiration date and the date to ask to 
backup the current Tracking List.

Any questions regarding the Password Tracker Deluxe Year 2000 Compliance can be directed to 
ptd@bigfoot.com.

Sincerely,

Carl L. Roth
Password Tracker Deluxe Development Team



Generate Password command (Edit menu)

Use this command to generate a new password using the Generate Password dialog box.    The new 
password will be temporarily placed on the clipboard and not saved in a P-Track.

Shortcuts

Toolbar:
Keys: CTRL+G



Change Password command (Edit menu)

Use this command to change the password of the selected P-Track.    The new password will be 
temporarily placed on the clipboard.    Press Ctrl+V to insert the new password into the other program.    
The clipboard will be cleared when the Change Password dialog box closes.

Shortcuts

Toolbar:
Keys: CTRL+H




